Release Notes for Nuke and
—Hiero 10.0v2

Release Date

08 June 2016

Qualified Operating Systems

* Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)
* Windows 7 or Windows 8 (64-bit only)
* CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested. If you have any problems with a particular
operating system, please visit supportportal.thefoundry.co.uk.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements. You
need to have:

* an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is
available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

\J
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software
update.

With graphics drivers capable of running CUDA 4.2 or above.

\J
NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is
required.

+ On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU.
Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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RELEASE NOTES FOR NUKE AND HIERO 10.0V2 | NEW FEATURES

* On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it
already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from
www.nvidia.com/drivers.

\J
g NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

* an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3 'Mavericks', or
later (see below and the Blink APl documentation for caveats on CPU/GPU result consistency on Mac Pros).

Late 2013 and Mid 2015 Mac Pros Only

Nuke 10.0 supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running OS X
10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

\J
NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1 and mid
2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full functionality.
However:

* If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega
pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.

* If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU
acceleration.

New Features

* Windows only: Nuke no longer requires a local installation of QuickTime to work correctly.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

+BUG ID 146791 - Windows only: Nuke would not start without QuickTime installed.

Known Issues and Workarounds

This section covers known issues and gives workarounds for them, where appropriate.
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Known Issues Specific to Nuke 10.0

*+BUG ID 201214 - Localization: Scripts containing multiple Read nodes that point to very long image sequences can
be slow to open with certain localization settings.

*BUGID 201193 - OCIO: Read node Metadata tabs occasionally include irrelevant in and out colorspace controls.

*BUGID 201156 - Flipbook: Nuke's flipbook defaults to the Write node's colorspace, which can result in different
output when compared to the Viewer.

As aworkaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT in the
Flipbook dialog.

BUG ID 200206 - OCIO: Read node controls are not set up correctly when the colorspace for the input file cannot
be found, even after choosing a different colorspace manually.

As aworkaround, manaully set the frame range control to the correct first and last frames.

BUG ID 199990 - Linux only: In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang
during startup.

As a workaround, update your drivers to 361.42.

BUG ID 199951 - Keyboard Shortcuts: The timeline editing tool shortcuts (Q, W, E, R, and T) currently only work in
the first timeline view created.

As aworkaround, close the timeline view and then double-click the sequence from the project bin to enable the
shortcuts.

BUG ID 198829 - OCIO: An lllegal lut requested (270), maximum lut index is 100 error is occasionally printed
in the terminal when opening and closing scripts.

These messages will be suppressed in a future release.

BUG ID 198401 - RayRender: Using the Camera skew on the Y/Z axes produces incorrect output when compared
with ScanlineRender.

BUG ID 198311 - EXR: Reading in an .exr sequence occasionally alters or corrupts the channel order when using
custom channel names.

BUG ID 196942 - RayRender: Textures connected to the src input of ModelBuilder are not rendered correctly.

As aworkaround, use an ApplyMaterial node between ModelBuilder and RayRender, and then use a Project3D as
the material piped into the ApplyMaterial mat input.

BUG ID 196455 - Smart Vector Toolset: Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.

As aworkaround, scrub to a different frame to remove the message.

BUG ID 195424 - Blackmagic Monitor Output: The last two frames are not displayed through the output device
when the playhead passes over a cut on the timeline.

*BUG ID 195051 - RayRender: The Wireframe shader node, located in 3D > Shader > Wireframe, is not supported
by RayRender.

*BUG ID 195004 - RayRender: Custom lens shaders/projection modes are not currently supported.
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*BUG ID 175605 - Smart Vector Toolset: Entering a partial file path in the SmartVector file control and then clicking
the file browser icon does not open the file browser.

As aworkaround, click OK on the error message and then click the file browser icon again.

* BUG ID 174849 - RayRender: The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

*BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp) > use GPU
for Viewer when possible enabled in the preferences, renders the alpha channel black.

*BUGID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to respond.

*BUG ID 162171 - Alembic: Cameras imported from .abc files calculate win_translate.y incorrectly using the
vertical aperture instead of the horizontal aperture.

*BUG ID 161633 - Convolve: Rendering scripts containing Convolve nodes from the command-line does not render
the first frame.

+BUG ID 154342 - ModifyMetaData: Adding a ModifyMetaData node to the node tree breaks concatenation.

+BUG ID 151907 - RotoPaint: Drawing or editing a spline in downrez mode when the RotoPaint node is not
connected directly to a Viewer, produces unexpected results.

Known Issues Specific to Nuke Studio and Hiero 10.0
* BUG ID 208193 - Export: Exporting sequences from the Project bin with Start Frame set to Custom in the Export
dialog does not include soft effects in the output.

+BUG ID 201150 - Localization doesn't work as expected on bin clips if they have been reconnected using the right-
click Clip > Reconnect Media option.

As aworkaround, save, close, and then reopen the project to start localization. Note that this workaround is not
applicable for Nuke scripts.

+BUG ID 200015 - Selecting mutiple bin clips can cause the right-click menu to respond slowly.

*BUG ID 199173 - Soft Effects: Adding multiple Text or OCIO effects occasionally causes dissolves between track
items to playback incorrectly.

+BUG ID 198361 - Soft Effects: Razoring track items and then retiming them allows you to add effects that overlap
track item cuts, causing Create Comp to fail.

+BUG ID 198348 - OCIO: Saving and closing a project that uses an OCIO config, and then relocating the Nuke install
path, causes a Could not load OpenColorlO config error on reload.

+ BUG ID 194880 - Soft Effects: Saving none in a Preset for the Burn-In effect does not work as expected.

+ BUG ID 175574 - Soft Effects: Undo and redo of Properties panel changes can be unreliable if a soft effect delete
is in the same undo stack.

*BUGID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times retains the
original localization policies settings.

*BUG ID 167058 - Linux only: Pulseaudio (ALSA) can causes Nuke Studio to crash or impair playback.
As aworkaround, you can stop pulseaudio:

* Open /etc/pulse/client.conf
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* Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not commented out.
* Call ps -e | grep pulse to check the process is still runnning.

+ Call pulseaudio --kill

* Call ps -e | grep pulse again to check the process has stopped.

*BUG ID 155479 - Export: The {projectroot} token adds // (forward slashes) to the path when chosen from file
browser.

As a workaround, manually delete a / (forward slash) before exporting.
Other Known Issues

Known Issues Specific to Nuke

AudioRead

+BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled between file and
custom.

* BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.

*+BUG ID 18465 - The time range control doesn't limit the range when an endtime is specified.

*+BUG ID 18451 - Flipbooking doesn't honor the time range knob.

+BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

+BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves correctly.

BlinkScript/CUDA

*+BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when
the OS wakes up from sleep mode.

As aworkaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker
*BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez modes.

+BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference
thumbnails, rather than just the RGB values.

Deep

* BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then writes it to disk,
causes Nuke to crash.

As aworkaround, run the script from the Script Editor inside Nuke.
*+BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.

As aworkaround, preview the .exr in the file browser before reading it into Nuke.
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Dope Sheet

* BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you execute
Analyze Sequence with the Dope Sheet open.

* BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.

+ BUG ID 39426 - Undoing individually animated text characters removes their keys completely from the Dope
Sheet.

* BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames when frame snap
is enabled.

+BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.

+ BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to have a non-
empty frame expression.

+BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.

+BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in the Dope
Sheet.

EditGeo

* BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on geometry with
animation baked into its vertices.

To update the transform handle, toggle the axis alignment control between object and average normal.

+ BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to ignore the
EditGeo node.

+BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe marker.

+BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and corner
vertices.

Flipbook

+BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even if the clip
doesn't start at 0.

+BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both rec709 and
rec1886.

GPU

+BUG ID 208949 - GTX 980: Filter nodes produce inconsistently slow frame generation.

* BUG ID 208934 - GTX 980: Rendering speeds are inconsistently slow, and the CPU locks at 100%, when using
QuickTime 7.7.9 with this GPU.

As a workaround, rollback the QuickTime version to 7.7.6, or earlier.

*BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.
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Import Nuke

+BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line arguments
unavailable.

As a workaround, preserve sys.argv in another variable before you import Nuke.
+ BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other applications.

+BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is available.

Linux only

*BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%, causing Nuke to
become unresponsive.

*+BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.

As aworkaround, launch Nuke from the command-line using:
LD PRELOAD=/1ib64/libuuid.so.l ./Nuke8.0

+BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a dialog box is open
displays an error.

+ BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

Mac OS X only

* Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA CUDA drivers
so that Nuke can detect your GPU correctly. You can obtain the required drivers directly from NVIDIA here:

http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.

+BUG ID 197564 - OCIO: Opening non-OClO scripts occasionally applies the OCIO config specified in the
Preferences.

+BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above, when writing to
SMB 2.1 and SMB 3 Sharepoint locations.

+BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the Terminal.
* BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

*+BUG ID 41981 - Licensing: Launching Nuke on new MacPros with multiple Thunderbolt devices may display a
licensing dialog explaining that FLEXIm licensing has been disabled, probably due to having too many ethernet
addresses active on the machine.

Please contact support@thefoundry.co.uk to work around this issue.

+BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save
Report.

*BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than one instance of
Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to
occur on GPUs with low amounts of RAM, such as the GeForce GT 650M.
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As aworkaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one
instance of Nuke at a time.

+BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure X11 is installed
on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default.

For more information, see http://support.apple.com/kb/HT5293.
+BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.
As aworkaround, either:

« tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or Samba, depending
on source), or

+ using the command-line, copy the installation from Mac OS X to the network location using the same file
system as the destination.

+BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.
As aworkaround, adjust the Viewer gain control to refresh the Viewer.

+BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when
Nuke is run from the command-line.

+BUG ID 13638 - The following graphics cards are not currently supported for Mac:
+ ATI Radeon X1600
+ ATI Radeon X1900

Users with these cards are able to render from the command-line, but in GUI sessions, the Node Graph renders
incorrectly due to a requirement of OpenGL 2 drivers.

+BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

+BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder
*BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

+BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a
ScanlineRender node causes Nuke to crash.

Monitor Out
+BUG ID 40942 - AJA 1o Express: Enabling monitor output causes Nuke to crash.
+BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

Particles

*BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not
render all frames to the .nkpc file.

*+ BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is out-of-date
errors for negative frame numbers.
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*BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off are not reliably
cleared when rendering through ScanlineRender.

* BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within
the particle system.

+BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
*BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.

*BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid
lines.

Pixel Analyzer and Scopes

*BUG ID 44176 - PixelAnalyzer: The full frame sampling mode doesn't work immediately in the timeline Viewer
when the analyzer is initially added to the layout.

*+BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the Viewer bounding
box to 1x1 for that frame.

* BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.

+BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color
transforms is enabled.

PrmanRender
* In the Nuke camera, the window roll control is not yet mapped to RenderMan.

* BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-in the
environment.plist file when in GUI mode.

See http://support.apple.com/kb/TS4267 for more information.

Python

*BUGID 215970 - The sample command doesn't work as expected from Nuke 9.0v8, onward. Both the Python,
nuke.sample(), and Tcl expression, [sample], are affected.

*+ BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes Nuke to crash.

*+ BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the
command-line.

Run the script from Nuke's Script Editor to avoid this issue.

* BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.

*BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command-line.
To work around this issue, run the Python script from Nuke's Script Editor.

*BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports incorrect values.

As aworkaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are currently
selected in the Node Graph.
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*+BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first created if it
has an autolabel.

+ BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at default (True)
may crash when too many node control panels are created too quickly. The workaround is to pass the in-panel
argument as False or else use nuke.nodes.NodeClass() (where NodeClass is the type of node to create) to create
the node and then connect it to the currently selected node manually.

BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the Script Editor as
that can cause Nuke to crash. Instead, you can use the same command from your menu.py, restore layouts by
selecting Layout > Restore Layout, or use a custom menu or toolbar item.

Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:
groupName.NodeName.knobname: unexpected 'k' in '0.knobname'’

The problem is most likely that there is an expression using the input TCL command and doesn't validate that there
is an input connected. An example expression:

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, which generates an expression of
'0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the value TCL
command and specify a default value to return in the case that the expression is invalid. It takes the form:

[value [input parent inputnumber].knob defaultValue]
Here is the modified example:
[value [input parent Ol.translate.x 0]

The modified example returns 0 in the event that there is no input 0, and no longer results in an error message.

There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>() if the knob is
called 'in'.

For example, this gives a syntax error:

nuke.nodes.Shuffle(in = 'depth’)

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth’)

Read and Write

+BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-line and GUI
modes.

+ BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file incorrectly.
* BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.

+BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an error
decoding frame message in the Comp Viewer.

*BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the rgba channels by
default.

+BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
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*BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color shifts using
QuickTime 10.3 codecs.

+BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444,
+BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes correctly.

*BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect while toggling
the read transform from file in combination with all objects and/or read on each frame.

*BUGID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a superfluous main
view.

+ BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces,
leaving gaps in certain circumstances.

This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the
geometry.

+BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
+BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files.
As aworkaround, ensure that ReadGeo > read on each frame is enabled.

*BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the
project, subsequent reads of any stereo/multiview .exr files won't give the option to add new views.

« If you have trouble with FBX files, it may be because they were written with an older version of FBX. If they load
very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the
FBX converter on the Autodesk website. It converts between various different formats, including older FBX
versions, ASClI, and binary, and is available on Windows, Mac OS X, and Linux.

To download the FBX converter:
1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?sitelD=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the following:

* If you're using the Sorensen Video codeg, it's recommended you use the Sorensen Video 3 codec instead. If you're
unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance.

* If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or above. You may
need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.

* If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint Open Splines

+BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the feather handles
in the Viewer.

*BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As aworkaround, select the shape and then manually change the Properties view control to include both views.
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*BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.

* BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative feather
values.

* BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave erratically.

*BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects in the hull or
feather.

*BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally produces
artifacts in the spline's hull.

*BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is set to 0.
*BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

+BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight rendering glitches
inside the hull.

+ BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly
from one point to the next

*BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open Spline and
Bezier tools.

Other Roto/RotoPaint Bugs
*+BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint color.

* BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe
creation.

+ BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same shape reverts
the shape to its original position.

*BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn't extend to the current frame, disappear
when drag-selected.

As a workaround, select the shape in the curves list to re-display the points.

* BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.

\J
g NOTE: This also applies to SplineWarp matrices.

+BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a
single smooth operation.

+BUGID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.

+ BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in
mind that they won't be backwards compatible with Nuke 6 once converted, unless you follow the instructions
below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:
* Click Save As to convert the script to the Nuke 8 Roto format, or

* Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:
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-You don't intend to make any changes, or
- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.

If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or convertDirectoryToNuke6 Python
functions when running Nuke 8 in command-line only mode:

\J
g NOTE: The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6.

* To convert individual .nk scripts:

convertToNuke6 (fromScript, toScript, overwrite = False)

* To convert all .nk scripts in a given directory:

convertDirectoryToNuke6 (fromDir, toDir, matchPattern =.*\.nk, overwrite = False)

\J
g NOTE: The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command-line (or Terminal):
$ <NukeInstallDir>/Nuke8.0v1l -t
>>> import nuke.rotopaint

>>> nuke.rotopaint.convertToNukeb6 (/tmp/myRoto8.nk, /tmp/myRoto6.nk)

*+BUG ID 26855 - The undo and redo buttons in the Properties panel didn't work as expected and have been
disabled.

The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the Edit menu
instead.

+BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another frame.

*+BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.

+ BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of the screen.

* The foreground onion skin overlay updates as you paint, rather than only updating with the new stroke on pen up.
* It is not currently possible to clone RotoPaint nodes.

* Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled on the layer
you are working in.

ScanlineRender
+ BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.

+ BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi
transparent areas.

*BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.

Text

+ BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control differently,
producing inconsistent output.
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+BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer overlay is
disabled.

* BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does not work as
expected.

As aworkaround, expression link the translate x and y controls separately.
*BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

+ BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame where the
character no longer exists, results in the transformation being lost.

+ BUG ID 39130 - Splitting the message field does not work as expected.
+BUG ID 38789 - Viewer toolbar controls steal cursor focus.
* BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

* BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in the Viewer.

Tracker

+ BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked
frames.

As aworkaround, you can enable full frame processing, though this may increase render times.

+BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor
coordinates to 0,0.

* BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.
*BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.
+ BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between frames.

+ BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn't always update the available Link to >
Tracker linkingdialog or Tracker options.

As aworkaround, close and re-open the Roto/RotoPaint properties panel to update the Link to menu.
+ BUG ID 29382 - Tracking keyframes with different sized patterns doesn't work as expected.

As aworkaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers

* BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display an overlay until
pen-up.

+ BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which
cannot be undone.

+ BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are removed.

*+BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be
undone.

*BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to a new layer.

*BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
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+BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the
cropped image and the black area between the crop box and the format when merged over a background.

* BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines.

+ BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set at an
intermediate value.

+BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering
problems.

*+BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode with mix set
at an intermediate value.

+BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather than just the
latest, and the keyframes remain on the timeline and in the properties.

*BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

*BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add Correspondence Point
tool.

+BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is
not visible in the Viewer.

+BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not
undo as expected.

*BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet.

+BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the
Draw Boundary Viewer button.

*+BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A shortcut.

+BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of the Viewer,
particularly when the grid is subdivided.

+BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split controls into
separate views.

Windows only

* Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then clicking Quit,
causes Nuke Non-commercial to crash on exit.

As aworkaround, change the mode a few times until it work as expected.

*BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you have a previously
saved FileChooser_Favorites.pref file in your ~/.nuke directory.

As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.

* BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you use the erase
end of the pen.

*+ BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422 (2vuy) pixel
format due to a bug in the codeg, resulting in solid green frames.

As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.
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*BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node, such as
Primatte or Shuffle, even after the node is removed from the Node Graph.

+BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous
+BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer script.

*+ BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4 when the NUKE_
AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather than SDI4.

+BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then changing a value,
such as Gain, causes Nuke to crash.

+ BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is changed.

* BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system occasionally
allows particles to pass through the bounce surface.

*BUG ID 42339 - The Modo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D control type)
does not work as expected.

* BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel doesn't work as
expected.

*+BUG ID 42159 - Nodes that use the lop::sample() call to get input pixels, such as LensDistortion, perform poorly
when they are downstream of nodes using Planarlop, such as Denoise.

+BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.

+BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as
the file path to the original.

a WARNING: If you save this empty script when the network drive is reconnected, the original is
overwritten.

*BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on the Target for
.mov clips with a frame range offset.

+BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous versions.

* BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-mouse button,
pastes values into the control.

*BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the Nuke<>Mari bridge
won't work unless all instances of Project3D are renamed appropriately in the mari_bridge.py file.

*+ BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.

* BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from the
Node Graph.

*BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.

+BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format sizes causes
corruption and constant refreshing in the Viewer.

+BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
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*BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in
error when the path doesn't exist:

Flipbook render failed: viewerCaptureOp: Cannot write to specified path
*BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images.

*BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when mousing over the
Viewer.

*+ BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

*BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when render is set to
off.

*BUG ID 32497 - The R3D parameter labels in Nuke aren't entirely consistent with REDCINE-X and Hiero.

*BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces
corrupt output.

As aworkaround, shuffle the depth information to an alternate layer.

*+BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset nodes are
ignored when connected to the cam or axis inputs.

+BUG ID 31803 - Using Shift+drag on a control's animation icon only copies the value for the current frame, not the
entire expression.

*+BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding
boxes for polymesh primitives.

+BUG ID 31310 - TimeOffset: Checking reverse input doesn't affect cameras, lights, or axes.

*BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it's unique identifier, causes the cache to
release. Actions such as adjusting the Viewer Gamma, Gain, or channels dropdown affect the frame hash.

+ BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

\J
g NOTE: This known issue only applies to Roto and SplineWarp keys.

* BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is
copy/pasted in the Node Graph.

*BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

*+BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only
displays the animated Camera in the Viewer. There should be two cameras: one static and one animated.

+BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the
new camera does not match that of the Viewer camera.

*BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no longer available.
+BUG ID 20431 - CameraTracker: It's not possible to pick colors in the Viewer with the control panel open.

* BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing downrez in
the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.

*BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer.
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+BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the
Properties panel.

*BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.

*+ BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because some large
polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry tessellation max parameter.
*BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or zooming.

+BUGID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and points drawn
with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and the other in 3D mode, and you
have the panel for the RotoPaint visible.

*BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit per frame is
50MB. If your frames are larger than this, you may need to switch to proxy mode for the caching to work.

+BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is not restricted
to, any nodes that have an analysis pass.

* BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install on Windows without specifically installing the run-time libraries, though
we still recommend that you do so as there are still some minor problems without them.

+BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render. This question is
unnecessary as the result is an anaglyph image. Irrespective of what view you choose, the flipbook output is the
same.

* File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so if you save a
script on NukeX using features that are only included in NukeX (such as CameraTracker or FurnaceCore) and then
double-click on the script icon to open it, it opens in standard Nuke instead of NukeX.

« CameraTracker: Canceling lens distortion initialization results in corrupt tracks.

+ 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node when using
Create Scene:

+ Select the Camera that was created in the 3D view when using the Create Scene button.

* Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to focus (using F)
on the point cloud. The resulting tumble camera movement is likely to be jumpy.

* Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled against an earlier
version of Nuke.

Known Issues Specific to Nuke Studio and Hiero

Create Comp
 Multi-view, such as stereoscopic, is not supported for track items created using right-click Effects > Create Comp.

+BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes Nuke Studio to
crash when the Text nodes are disabled.
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*BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the comp frame
range compared to the annotations precomp frame range.

*BUG ID 41665 - There are currently no options to load or overwrite an existing script when you select Create
Comp.

Exporting
+BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the Media tab
Output Resolution setting for the track above, and produces output with incorrect formatting.

* BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when imported into Final
Cut Pro.

+BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values from the Nuke
Write Node Content preset.

Linux Only

* Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio on Linux is
scheduled for a later release.

*BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes Nuke Studio to
crash.

As aworkaround, ensure that you have the latest NVIDIA drivers installed, available from:

www.nvidia.com/Download/index.aspx?lang=en-us

Mac OS X Only
*BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and earlier.
This is a codec issue rather than an application issue.

*BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to a conflict
with the combination for the umlaut symbol.

To work around this, press U momentarily before Alt+U.

Preferences

* The Preferences > Path substitution table for cross platform compatibility currently only comes into effect at
project load, not EDL/XML import.

As aworkaround, import your sequence and set the Path substitution rule, then save the project and reload to
force the conversion.

Python API

+BUG ID 50113 - QActions are not added to the Edit menu in the menu bar when finding the menu action by name.
As a workaround, use the objectName (foundry.menu.edit), where possible.

+ BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.
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Read and Write
*BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in HieroPlayer 9.0.
*+BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml files.

+BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the Rendering
preference set to limit renderer.
As aworkaround, you can change the preference Performance > Threads/Processes > Rendering > export
renders to no renderer limits to improve rendering speeds. You can also experiment with the custom renderer
limits to adjust performance on your machine.

+ BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

* BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.

*BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds frames to the
clip.

+ BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to other applications,
such as Premiere or Resolve.

*+ BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default Nuke layer, such
as depth or motion.

+BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.

+BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when added to the
timeline.

Soft Effects

+BUG ID 50442 - TimeWarp: Applying a TimeWarp to a track item occasionally causes the associated sequence bin
item to display an error.

+BUG ID 50441 - TimeWarp: Applying a TimeWarp to track items retimed to values other than 100% does not work
as expected.

*BUG ID 49771 - Text/Burn-in: Nuke Studio doesn't warn you if the font used in an effect could not be found.

*+ BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between sequences until the
playhead is moved.

+BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the examples
provided here:

<install directory>/pythonextensions/site-packages/hiero/examples/custom soft
effect.py

*+ BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying metadata is
updated.

As aworkaround, either change the frame displayed in the Viewer or choose an alternate element from the
dropdown controls.

+ BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the timeline.
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+ BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above, causes text
rendering to fail during the transition.

+BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above, causes the text
Size to reset.

+BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression writes incorrect
frame numbers.

+ BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the Properties
panel, if the node and effect names are identical.

* BUG ID 42438 - Effects are only visible in the Viewer if there is a track item below them in the timeline.
*BUG ID 42401 - Renaming a soft effect does not update the track item until you click in the timeline.

*BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available using the toolbar
button on the timeline panel. The right-click Effects menu is currently disabled.

Timeline

+BUG ID 43913 - Locking a track currently prevents adding track items from the locked track to the Viewer input
buffers. You can still open track items in the various right-click Open In options and access track item metadata.

*BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below existing tracks.
As aworkaround, drag the clip to a new top-level track and then manually move the track to the required position.

+BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the right-click
Open in Timeline option.

Windows Only

+ BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size depending on the
timecode displayed.

+BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous
+ BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the timeline.

*BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke default workspace
causes Nuke to crash on start up.

*BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.
* BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
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Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more information.

z NOTE: Node Class() names occasionally change between major releases, such as Nuke 9 to Nuke 10.
While these changes do not affect legacy scripts, you may not get the results you were expecting if a node
class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current
node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

There are no bug fixes in this release.
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Release Notes for Nuke and
Hiero 10.0v]

Release Date

27 April 2016

Qualified Operating Systems

* Mac OS X 10.9 (Mavericks) or 10.10 (Yosemite)
* Windows 7 or Windows 8 (64-bit only), with the latest version of QuickTime installed
* CentOS/RHEL 5 or CentOS/RHEL 6 (64-bit only)

Other operating systems may work, but have not been fully tested. If you have any problems with a particular
operating system, please contact support@thefoundry.co.uk.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements. You
need to have:

* an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is
available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

\J
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software
update.

With graphics drivers capable of running CUDA 4.2 or above.

\J
NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is
required.

+ On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU.
Drivers from April 2012 onward support CUDA 4.2.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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* On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it
already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from

www.nvidia.com/drivers.

\J
g NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.

* an AMD FirePro GPU on late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5, running OS X 10.9.3 'Mavericks', or
later (see below and the Blink APl documentation for caveats on CPU/GPU result consistency on Mac Pros).

Late 2013 and Mid 2015 Mac Pros Only

Nuke 10.0 supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 and mid 2015 Mac Pro 11,5 (running OS X
10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences,
GPU processing is shared between the available GPUs for extra processing speed.

\J
NOTE: To ensure you get the best performance from OpenCL GPUs on late 2013 Mac Pro 6,1 and mid
2015 Mac Pro 11,5, we recommend updating Mavericks to 10.9.5, or above for full functionality.
However:

* If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater than 4 mega
pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.

* If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not support GPU

acceleration.

New Features

AMD GPU Support

Similar to the work done for the late 2013 MacPro 6,1, Nuke now supports AMD OpenCL-only GPUs for mid 2015
MacBook Pros 11,5 or later.

ARRIRAW SDK

The ARRI SDK third-party library has been updated to version 5.1, which adds some new color space options and
ADA-5 debayer controls.

Audio Scrubbing

Nuke Studio and Hiero's timeline now supports audio scrubbing, allowing you to synchronize audio and video more
easily. Audio scrubbing is disabled by default, but you can enable it by right-clicking in the timeline tab and clicking
Audio > Audio Scrubbing or by pressing Ctrl/Cmd+Alt+S.
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ChromakKeyer

ChromaKeyer is a green and blue screen keyer developed for use as a soft effect in Nuke Studio's timeline
environment. It can also take advantage of modern GPUs and multi-core CPUs to accelerate the keying process
when used for compositing in Nuke's Node Graph.

Use the screen color selector to choose a color from the Source input to use as the blue/green screen color. To
remove blue/green spill from the foreground object, use the despill controls to pick skin tones from the source. Use
the matte parameters to improve the matte.

Multi-NVIDIA GPU Support

Nuke now supports multiple identical GPUs on a single machine. For example, if you have two GPUs in your machine
that both have the name Quadro K5000, Nuke can use both of them for GPU-accelerated nodes, sharing the work
equally between them if enable multi-GPU support is turned on in the Preferences.

\J
NOTE: If, for example, you have a Quadro K5000 and a GeForce GTX 580 on your machine, you can still
choose which one to use for GPU acceleration, but the enable multi-GPU support option is hidden.

Most GPU-accelerated nodes utilize all the identical GPUs that they find, but the following nodes are limited to using
no more than two identical GPUs only:

* MotionBlur

* Kronos

* VectorGenerator
* OFlow

RayRender (Beta)

Nuke now ships with another render node, RayRender, a ray-tracing renderer that traces a path from the camera, or
virtual eye, to the light source pixel-by-pixel, rather than row-by-row, advancing down the picture like
ScanlineRender.

RayRender generally produces very accurate reflections, but at the cost of processing time. You can use RayRender in
the same way as ScanlineRender, it has the same inputs and shares some of the same controls as ScanlineRender.

\J
NOTE: RayRender does not support Nuke's Deep toolset, so use ScanlineRender if your script calls for
Deep data. Additionally, RayRender cannot render sprite-based particles from NukeX's Particles system.

RayRender isn't quite as stable as we would like, but we still want to give you a chance to try it out, so we have
included it as an unsupported feature in Nuke 10.0v1. We'll keep working on this feature, so keep an eye out for
fixes in an upcoming maintenance release.
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Please keep in mind that the RayRender node is in the beta phase and should not be used in production. Send any
comments or feedback to the Nuke team at nuke-prerelease-private@thefoundry.co.uk.

Smart Vector Toolset

The Smart Vector Toolset allows you to work on one frame in a sequence and then use motion vector information to
accurately propagate the paint throughout the rest of the sequence. The vectors are generated in the SmartVector
node and then piped into the VectorDistort node, so you only need to render the motion vectors once.

The basic workflow is as follows:

1. Connect the SmartVector node to your footage and specify a file path in the node's Properties panel.

\J
g NOTE: You can only write motion vectors to the .exr format.

2. Click Render to generate the necessary motion vectors.

\J
NOTE: The vector detail control defaults to 0.3, which should be fine for basic sequences with low detail,
but you can adjust the slider as required. Higher values take longer to render, but can improve the result.

3. Locate a good reference frame in the sequence and add the required paint to the frame.

4. Add aVectorDistort node downstream from your corrections and then connect the SmartVector node to the
SmartVector input.

5. Merge the alpha output of the VectorDistort node over the original footage to complete the comp.

Soft Effects

Nuke Studio and Hiero now include three new soft effects: BlinkScript, ChromaKeyer, and ColorCorrect. The
BlinkScript and ColorCorrect effects work in the same way as the existing Nuke nodes. ChromaKeyer is a new Nuke
luminance keyer with GPU acceleration. See ChromaKeyer for more information.

\J
NOTE: The BlinkScript effect has limited functionality compared to the full BlinkScript node from Nuke's
Node Graph. The soft effect version only supports one input source and produces only one output, and
you cannot publish kernels.

Transcode Performance Improvements

A new option, Read All Lines (Where Possible), has been added to Nuke Studio and Hiero's Export dialog when
transcoding from .dpx to ProRes 4444 and 422. The new option, enabled by default for .dpx to ProRes 4444 and
422, can improve performance for I/0 heavy exports by reading whole .dpx files in one chunk, rather than line-by-
line.

(8)NUKE RELEASE NOTES 26


mailto:nuke-prerelease-private@thefoundry.co.uk

RELEASE NOTES FOR NUKE AND HIERO 10.0V1| FEATURE ENHANCEMENTS

Feature Enhancements

Faster RotoPainting

The Paint tools in Nuke's RotoPaint node have been improved, including performance in general and iterative
optimizations on multiple paint strokes.

Localization System Improvements

Nuke, Nuke Studio, and Hiero now employ the same improved localization workflow, controlled initially from the
Performance > Localization preferences and then on a file-by-file basis. Improvements include:
* The localization process has been moved onto a background thread, meaning you can now continue to work while
localization carries on in the background.
* When localizing Read nodes, the orange localized indicator bar on the node now updates in real-time, filling up’ as
the localization process is carried out.
* The Cache > Localization menu has been rewritten for clarity and now includes the following controls:
* Pause - pauses all localization actions. All currently localized files are used during playback, and any localization
actions in progress are paused.
* Always Use Source Files - forces Nuke to use the source file from the original location, regardless of whether
the file has been localized or not. All currently localized files remain on disk.
* Force Update > All - forces all localized files to be checked against source files, and (where appropriate) re-
localized if the source is newer than the localized versions.
* Force Update > Selected - forces selected localized files to be checked against source files, and (where
appropriate) re-localized if the source is newer than the localized versions.
* Delete Unused Local Files - deletes any files from your localization directory that are not being used in the
current session, freeing up useful space on disk.
*+BUGID 157070 - The Preferences now include an option to never check for updated files, forcing Nuke to use
the localized versions of your source clips.
*BUG ID 160828 - Dragging localized bin clips to the Node Graph now reads the localized files, rather than the
source files.

OpenEXR 2.2

The OpenEXR library that ships with Nuke, Nuke Studio, and Hiero has been updated to version 2.2, which includes
the addition of DWAA/DWAB compression.
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OpenColorlO

You can now apply OpenColorlO color transforms directly to Read inputs and before Write outputs, without the
need to add OCIOColorspace nodes to your Node Graph. The Color Management options in the Project settings
have been updated to govern this functionality. When Nuke is selected, Reads and Writes work the same as in
previous versions of Nuke, with no integrated OCIO transforms.

When OCIO is selected:
* Reads and Writes use OCIO transforms, with no Nuke built-in LUTs applied to the image.

* Read and Write colorspace controls are populated with the list of colorspaces defined in your currently selected
OCIO config.

* The default LUT settings menus are also populated with the list of colorspaces or display transforms defined in
your OCIO config. The default value for each menu matches the defaults in a Nuke Studio project with the same
config. These defaults can be overridden by Python callbacks.

* Anew working space option has been added to the Project Settings. The working space allows you to change
the colorspace that Nuke uses internally for its image processing. This automatically sets the 'in' colorspace of Write
nodes and Viewer Processes, and the 'out' colorspace for Read nodes. This defaults to the scene linear role
defined in your OCIO config.

* Nuke Studio-created comps no longer include automatically injected OCIOColorspace nodes. Instead, OCIO color
management is automatically set in the comp’s Project Settings, and the correct OCIO colorspace is set directly
into the Read and Write nodes.

In addition, whether using Nuke or OCIO color management, it's now possible to override the default colorspace
used for any Read or Write node using Python callbacks. See Developer Notes for more information.

Timeline Performance Improvements

Various performance improvements have been made to enhance customer experience when working with Nuke
Studio and Hiero's timeline:

« Significant improvements in interactivity when performing edits in large or complex sequences, including major
optimizations in the spreadsheet view.

* Improved memory handling, which previously tended to increase in the course of a session when working with
large projects.

* The load time of large projects has been reduced.

« Improvements to the stability of playback. These improvements address causes of intermittent drops in
performance, some cross-platform and others specific to Linux.

VectorBlur

Nuke's VectorBlur node has been re-implemented to provide GPU acceleration and improved CPU performance.
Additionally, improvements have been made to the algorithm to reduce the hard edge artifacts that were common
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between regions with different motion when using the existing VectorBlur node.

Miscellaneous

+ BUG ID 130455 - The CameraShake node's class has been incremented to CameraShake3 to allow expressions to
access the seed control for Y axis transforms.

+BUG ID 145082/173220 - The BlinkScript node and soft effect now support float3x3 and float4x4 matrix
constructors.

*BUG ID 148433 - Conform: Nuke Studio and Hiero's Conform Options dialog now includes a Split sequences
checkbox. When enabled, any non-contiguous file sequences found by the conform are split into separate clips,
similar to the file browser's split seq option.

* BUG ID 156286 - Nuke Assist: Blur has been added to the white list of nodes available within Nuke Assist.

+BUG ID 160221 - Documentation: The descriptions for the various preferences under Performance > Caching
have been improved.

+BUG ID 162077 - MXFReader: Nuke can now read YUV jpeg-compressed .mxf files.

* BUG ID 169843 - BlinkScript: In addition to the initial dialog describing compilation errors, BlinkScript now displays
an error in the Viewer.

Bug Fixes

\J
NOTE: The more eagle-eyed among you may notice a jump in bug identification numbers in these release
notes. This is due to internal bug logging and tracking process improvements. There is some overlap
between the two systems, so we'll provide both bug numbers, where appropriate.

*BUG ID 132535 - Stereo: Caching and rendering views from the SideBySide node was not working as expected.

*+BUG ID 135551 - RotoPaint: Setting the proxy mode dropdown to format in the Project Settings caused
selected points in the Viewer to translate incorrectly.

*+ BUG ID 135955 - Roto: A customer script containing certain Roto nodes caused Nuke to crash.
*+ BUG ID 145290 - Scripts containing a Read and DeepRead did not distribute channels in layers correctly.

*BUG ID 146860 - Windows only: Accessing Nuke using remote desktop/VNC caused text in the Node Graph to
render upside down.

+BUG ID 146958 - Export Dialog: Audio .wav files were one frame short when Process as Sequence was selected
in the Export dialog.

+ BUG ID 147343 - Soft Effects: Adding multiple Text effects to the timeline occasionally caused GL error at line
1746: 500 (invalid enum) messages to display in the Viewer.

* BUG ID 149345 - Localization: Read and DeepRead nodes referencing relative file paths never localized files.

+BUG ID 150060 - Viewers: Closing the Preferences dialog caused Nuke to discard the playback cache, if clear
cache when the application goes to the background was enabled under Preferences > Performance >
Caching.

*BUGID 151632 - The Pause button was missing in the Export Queue panel.
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*BUG ID 152389 - Export Dialog: Controls set to the default value in the Content tab were overridden by Nuke's
Write node defaults.

*BUG ID 152584 - DeepRead/DeepWrite: The version up and version down hotkeys didn't work as expected in the
Properties panel.

*BUG ID 154900 - QuickTime: Rendering ProRes using the mov64writer failed for certain formats.
*BUG ID 155356 - Attaching a Viewer to a heavy node tree in a customer script caused Nuke to crash.

+BUG ID 155602 - Timeline: Editing track items in long timelines with many cuts was noticeably slow or
unresponsive.

+BUG ID 156103 - Comp Viewer: Changing the Frame Silder Range from Global to Input stopped cached frames
playing back at the required frame rate.

+BUG ID 156118 - XML: Timelines imported from Final Cut Pro did not allow track items to be retimed or reversed.
*BUGID 156171 - Export: Writing sequences to .mov using the h264 codec caused Nuke Studio to crash.

+ BUG ID 156334 - Expressions: Node Graphs containing multiple expressions occasionally caused some expressions
to be evaluated at the wrong frame.

* BUG ID 156349 - RotoPaint: The bounding box was calculated incorrectly in proxy and downrez modes.

+BUG ID 156898 - Export: Attempting to export a 48 fps.mov to .mov using the Apple ProRes 4444 codec caused
Nuke Studio to crash.

+BUG ID 157013 - Export: Setting Colorspace to raw when transcoding produced comps with the wrong
colorspace.

+BUG ID 157377 - Importing a large number of files caused Nuke Studio to leak memory during thumbnail
generation.

*BUG ID 157556 - Performance: Playback never reached 24 fps when the frame slider range was set to Input.
*BUG ID 157636 - Write: Custom Write nodes now support extensions beginning with non-alpha characters.
+BUG ID 158191 - Tcl expressions produced unexpected results in a customer script.

+BUG ID 158509 - Mac OS X and Windows only: Importing certain customer JPEG2000 .mxf files caused Nuke to
crash.

+BUG ID 158921 - Export: Writing sequences to .mov using the h264 codec occasionally produced a 1 KB file or
caused Nuke Studio to crash.

*BUG ID 159009 - Stereo: Switching views in A/B mode occasionally caused buffer output to disappear and
reappear.

+BUG ID 159216 - Soft Effects: Adding Burn-In effects printed GL errors on the command-line.
* BUG ID 159854 - BlinkScript: Publishing BlinkScripts inside a Group did not work as expected.

*BUG ID 160112 - Reading image files with no extension using reader prefixes (jpg:, dpx:, and so on) did not work
the same as in previous versions of Nuke.

*BUG ID 160408 - VectorBlur: A customer script that rendered correctly interactively, failed to render from the
command-line.

+BUG ID 160563 - Soft Effects: Adding an effect to a comp clip stopped you switching between versions of the
comp.
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*+BUG ID 160739 - RotoPaint: Setting the proxy mode dropdown to format in the Project Settings caused
selected points in the Viewer to translate at the wrong scale.

*+BUG ID 161325 - Writing .mov files using the mov64 encoder and Avid DNxHD codec at certain resolutions
caused Nuke to crash.

*BUGID 161461 - SplineWarp: Adjusting a selection bounding box in a customer script caused Nuke to crash.

+BUG ID 161508 - Localization: Selecting Delete Unused Local Files and then re-opening a project without
relaunching Nuke Studio caused auto-localize to stop working.

*BUG ID 161612 - IDistort: Processing vertical gradients in UV channels did not work as expected.

*BUG ID 161630 - QuickTime: Rendering certain Apple ProRes 422 clips created corrupt .mov files.

*BUG ID 161714 - Localization: Comp container output could not be localized.

*BUG ID 161747 - The Tcl version command returned the wrong version.

+BUG ID 161805 - Export Dialog: Creating or modifying export presets occasionally caused Nuke Studio to crash.
*BUG ID 161840 - Localization: Clicking Clear unused files didn't work when localization was disabled.

*BUG ID 161969 - ARRIRAW: Previewing a customer .ari file in the file browser caused Nuke to crash.

* BUG ID 162064 - Export: Transcodes in a customer project failed when Render with > Single Render Process
was selected for certain export presets.

*+BUG ID 162149 - Timeline: Copying and pasting a clip into the timeline failed to display an image in a customer
project.

+BUG ID 162162 - Export: Transcoding track items with audio to Apple ProRes 4444 locked at 98% in a customer
project.

*BUG ID 162254 - ZDefocus: Switching filter type to image caused Nuke to crash.

+BUG ID 162306 - Rendering Apple ProRes .mov files at resolutions containing odd numbers displayed an unable
to open video codec error.

+BUG ID 162324 - Build Track from Export Structure occasionally failed due to an extra / (backslash) before the
{projectroot} token in the Export dialog.

*BUG ID 162417 - Export: Attempting to export a customer sequence containing a .dpx track item caused Nuke
Studio to crash.

*BUG ID 162420 - Copying nodes from earlier versions of Nuke into Nuke 10 occasionally caused QuickTimeHelper
processes to become unresponsive, freezing the application.

*BUG ID 162516 - Multi-GPU: Contexts were created for all GPUs, including those unused, resulting in unnecessary
memory usage.

*BUG ID 162522 - A customer script spawned a large number of threads when rendered from the command-line,
when compared to rendering the same script interactively.

*+BUG ID 162582 - Export: It was not possible to write .mov files at 48 fps.

*BUGID 162679 - Export Dialog: The .jpg exporter's quality control was positioned at 0.1 by default, but the
actual value was set at 0.75 during export.

*BUG ID 162717 - Reading file sequence clips (such as .exr and .jpg) on the timeline failed if the first frame
contained a different number of channels to subsequent frames.

*BUG ID 162741 - PSD: The rgba channels in certain .psd files were not readable.
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+BUG ID 163061 - The version string printed to the Terminal or command-line on start-up didn't adhere to the new
versioning format.

*BUG ID 163108 - ARRIRAW: Reading in certain anamorphic Arri Alexa XT RAW files displayed a Scaling mode
Native 2880px not available for input image size 2592 x 2160 error.

*BUG ID 163234 - MotionBlur: Nuke attempted to find motion vectors on frames before the first frame of the clip,
resulting in a CUDA error. This bug occasionally caused Nuke to crash on multi-GPU machines.

*BUG ID 163255 - R3D: Changing the Gamma Space in the Media tab displayed QObject: Cannot create
children for a parent that is in a different thread errors on the command-line.

+BUG ID 163307 - Writing .exr files from a DeepEXR input upstream with all metadata enabled failed.
*BUG ID 163331 - Planarlop nodes employing large bounding boxes caused malloc failures.

+BUG ID 163422 - Timeline Viewer: Toggling track visibility in certain timelines caused the Viewer to display incorrect
frames.

+ BUG ID 163478 - Keyboard shortcuts in the Viewer mouse-over context did not behave consistently.
+BUG ID 163554 - Conform: Importing certain .aaf files caused Nuke Studio to crash.
*BUGID 163561 - Mac OS X 10.11 only: Mousing-over the compositing Viewer stopped the Viewer updating.

+BUG ID 163597 - Sequences with no file extension were not collapsed in the file browser when sequences was
enabled.

*BUG ID 163606 - Connecting an OFX node, such as F_Regrain, to a Dilate node with a non-zero size setting caused
Nuke to crash.

+BUG ID 163609 - Soft Effects: Clicking in the Viewer and then undoing the action with a soft effect's Properties
panel open, caused Nuke Studio to crash.

+BUG ID 163628 - Disabling a Read node and then modifying its file control displayed an exception in the Script
Editor.

+BUG ID 163636 - Soft Effects were occasionally not applied on the first frame of track items directly after a cut.
+BUG ID 163641 - The timeline was occasionally rebuilt unnecessarily after loading a project.
* BUG ID 163800 - RotoPaint: Moving the Brush tool produced trails when proxy mode was enabled.

*+ BUG ID 164825 - Documentation: There was no information on the compositing Viewer's info bar in the online
help.

+BUG ID 165147 - Windows only: Enabling the Stroke > pressure alters controls caused blobby strokes when
using Wacom tablets.

*BUG ID 166235 - Mac OS X 10.11 only: Using a Wacom tablet to resize brushes or adjust Viewer widgets did not
redraw the Ul until the cursor motion ceased.

+BUG ID 166728 - Exporting .xml sequences from Nuke Studio and then re-importing them resulted in incorrect
timecodes.

*BUG ID 167728 - VectorBlur: Connecting a VectorBlur downstream of ZDefocus and Defocus nodes caused Nuke
to crash.

*BUG ID 167795 - Passing infinite values into the HistEQ node caused Nuke to crash.

+BUG ID 167982 - Dynamic knobs weren't added to panels unless the panel was closed and re-opened.
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+BUG ID 168305 - Disabling nodes within a Backdrop node in a customer script caused Nuke to crash if nodes
existed outside the Backdrop.

*+BUG ID 168868 - Export: A customer sequence containing audio exported incomplete .wav files.

* BUG ID 168924 - Import: Importing multiple sequences disconnected the linking behavior between the timeline,
Viewer, and spreadsheet panels.

*BUGID 169022 - Timeline Viewer: The gamma control did not affect the alpha channel.
+BUG ID 170469 - Copying nodes in a second instance of Nuke caused the application to crash.
+BUGID 170921 - VectorGenerator: Scripts containing sequences with varying bounds caused Nuke to crash.

+BUG ID 171395 - Opening a script containing a connected Viewer from the command-line displayed a No render
channels - fetching plane direct from input error message.

*BUG ID 172625 - Export: Selecting Apple ProRes 422 as the codec for exports was slow to transcode.

*BUG ID 173415 - Project Settings: Clicking Script Directory in the Root tab, followed by the folder file browser
icon, caused Nuke to crash.

*BUGID 173616 - Write: The colorspace control in Write nodes did not update after changing LUT in the Project
Settings.

+ BUG ID 173728 - Soft Effects: Keyframes on TimeWarp effects were not updated correctly after the effect was
moved on the timeline.

+BUG ID 173965 - Stereo: View selection stopped working when Project Settings > Views > View selection uses
buttons? was disabled.

+BUG ID 174510 - Linux only: The font in BlinkScript's Kernel Source dropdown was incorrect.
*BUG ID 175319 - Documentation: Links to the OpenColorlO website were out of date in the online help.

+BUG ID 175609 - Editing a customer script printed Channels changed - invalidating old unused channels on
the command-line.

*BUG ID 176234 - OCIO: The colorspace ‘family' was ignored in some Nuke Studio colorspace menus.

*BUG ID 176331 - Connecting a non-zero Erode (fast) or Dilate node to a Denoise node occasionally caused Nuke to
crash.

*BUG ID 176369 - Deep: Shuffling mismatched channels downstream of a DeepHoldout node caused Nuke to
crash.

*BUG ID 176409 - OCIO: The Export dialog only listed nuke-default colorspaces, regardless of which config was
specified in the Project Settings or Preferences.

*BUG ID 191909 - Certain .exr clips displayed incorrectly in the timeline Viewer.

+BUG ID 191951 - Certain .exr clips caused a drop in read performance on the timeline.
+BUG ID 194982 - Selecting views from the overflow menu was not working as expected.
*BUG ID 195290 - The SideBySide node produced inconsistent output.

*BUG ID 195629 - OCIO: The Colour Space dropdown in the Media tab displayed Nuke-native colorspaces when
an OCIO config file was specified.

*+BUG ID 196650 - OCIO: The viewer color transform was not set after Flipbooking with the aces_1.0.1 OCIO config
file selected.
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Developer Notes

Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/100/ndkdevguide/appendixc/index.html for more information.

z NOTE: Node Class() names occasionally change between major releases, such as Nuke 9 to Nuke 10.
While these changes do not affect legacy scripts, you may not get the results you were expecting if a node
class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current
node class names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand ("CameraShake", "nuke.createNode (\"CameraShake3\")",

icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

PySide

The PySide library that ships with Nuke has been upgraded to version 1.2.2.

OpenColorlO

You can now override the default colorspace used for any Read or Write node using Python callbacks. See <install_
directory>/plugins/nuke/colorspaces.py for the default implementation. Additionally:

« Two new functions, nuke.addDefaultColorspaceMapper and nuke.removeDefaultColorspaceMapper, have
been added to the Nuke Python API.

* The expected callback function signature is functionName(colorspace, dataTypeHint) where:

+ colorspace - the name string of the initial colorspace.
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+ dataTypeHint - whatever the Read/Write node has detected as the data type for that particular file. For
example, sometimes Readers/Writers request the default for a particular data type, such as nuke.INT8,
nuke.INT16, nuke.FLOAT, and so on. If no data type is specified, this is -1.

* Each of the registered functions are called in turn.

* You can now access nuke.thisNode() functionality so that you can transform the colorspace name based on data
on a certain node.

* You can use the nuke.usingOCIO function to determine if a .nk script is using OCIO.

Miscellaneous
*BUG ID 140640 - The Python API for Viewer playback has been improved, including the following methods:
goToPrevEdit
goToNextEdit
goToPrevTag
goToNextTag
goToTag
goToInTime
goToOutTime
goToTrackItemStart
goToTrackItemEnd
goToTrackItemMiddle
*+ BUG ID 159255 - The AxisOp::matrixAt call is now a virtual function.
*+BUG ID 196133 - Two new functions have been added to the Nuke Python API to control .r3d and .ari clip
colorspace programmatically:
+ setCameraColourTransform - sets the OCIO color transform for a clip from those available.

+ getAvailableOcioColourTransforms - returns a list of OCIO color transforms that can be set on a clip.

Bug Fixes

*+BUG ID 154195 - SplineWarp: Generating B-splines Pythonically did not work as expected.

*+BUG ID 158544 - Documentation: The NDK Dev Guide listed an error for ImagePlane::writableAt() arguments.

*BUG ID 162948 - Linux only: The call to malloc_trim(0) from CompositeDecodeFrame slowed playback down
significantly.

+BUG ID 163056 - Calling nuke.env['"NukeVersionString"] did not return the new versioning format.

+BUG ID 163059 - Calling nuke.NUKE_VERSION_STRING did not return the new versioning format.

*BUG ID 163446 - Removing the SLIDER flag from an Array_Knob did not allow the knob to expand to the width of
the Properties panel.

*+BUG ID 163535 - Setting nuke.knobDefault("Root.views_button”, "false") caused Nuke to crash on startup.

+BUGID 163611 - Hiero API: The VersionMajor, VersionString, VersionMinor, and VersionRelease keys were
missing.
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+BUG ID 164615 - PySide: Custom PySide widgets caused Nuke to crash on exit.
*+BUG ID 171492 - NDK: Plug-ins using the Python CAPI caused Nuke to become unresponsive in terminal mode.

*+BUG ID 195154 - Roto: Calling featherCenter did not return the correct vector position value.
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